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1. Overview

FredoGhost is a Proxy framework for SketchUp. By ‘proxy framework’, I mean the
capability to temporarily replace an object by another one, the proxy, and switch back and
forth between the original version and the proxy version.

In FredoGhost:

A Proxy is called a Ghost, and the original object is called a Real.

FredoGhost operates on Components and Groups, called generically Objects.

FredoGhost provides several methods to generate a Ghost from a Real object. These
Ghost Methods are split into 3 main categories:

Styling methods, which change the material of faces and edges to simulate some
generic styles like Xray, Wireframe, Edge-mesh, Color masking. The main
interest is that you can apply styles to individual objects, whereas SketchUp
currently applies styles uniformly to all objects in the model.

Simplifying methods, whose purpose is to construct a lighter version of real
objects to ease the navigation in SketchUp viewport, typically bounding box, no
texture, and simplification methods. You can also create a ghost as a frozen
version of an object, and then continue working on the real object (say you freeze
the ghost of a cube, and then make corner rounding and add other details).

Proxy method, allowing to replace a real object with an arbitrary object picked in
the model.

FredoGhost provides some optional features:

You can auto-switch between Real and Ghost based on the distance of the
object to the viewport camera. If an object is far away, it will dynamically switch
to its ghost version. This can be useful if you have heavy objects and want to
replace them with a lighter version when they are far away in the model viewport.

You can attach a Ghosting state to Scenes. Then, pushing the Scene tab will
recall this state.

FredoGhost is compatible with Layout. So, you can build your documentation
with mixed styling for objects in different scenes.

Credit: in this documentation, all furniture objects are by DaveR, unless specified
otherwise. Dave was also very helpful to advise about the functionality.
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2. Installation
» SketchUp Versions: SU2016 and above (Make and Pro).
» Platforms: Windows and Mac OSX
» IMPORTANT: FredoGhost requires the Shared Library LibFredo6.
FredoGhost is hosted at the Sketchucation site.

There are now several ways to install a plugin.
- SCF ExtensionStore, recommended method
- SketchUp Extension Warehouse (EWH )
- SU Extension Manager to manually install a .rbz file

Instructions for installation of FredoGhost and LibFredo6 can be consulted at:

https://sketchucation.com/plugin/2191-FredoGhost

All installations must end up with the following footprint in the SketchUp Plugins
directory:
e one script file Fredo6_FredoGhost.rb

e one subfolder Fredo6 FredoGhost. This subfolder contains the library files, the
icons, cursor files, language files, ...

Name | Type
| SU Plugins root directory Plugins Root Folder
e Fredo6_FredoGhost Folder
4 Fredo6_FredoGhost.rb Ruby file
el Fredo6_!LibFredo6 Folder
4 Fredo6_!LibFredo6.rb Ruby file

CAUTION: NEVER rename or move files from their folders.

Note: you can select an alternative plugin directory (see AdditionalPluginFolders at
http://sketchucation.com/forums/viewtopic.php?f=323&t=39073#p345150).
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3. Menus, Toolbar and Configuration

I Toolbar I

Toolbar name is Fredo6_FredoGhost by default. There are 11 icons'.

Fredo6_FredoGhost

&
BRI 2BKa®A

By default, in Tools > Fredo6 Collection > FredoGhost. All functions are available in
this menu, whether shown or not in the toolbar.

Quick Launcher

Ghost Studio
Create Ghost (current method)

Animator >
Ciniloft 5 Switch to Ghost
Guiryizard 5 Switch to Real
FollowUs > Refresh after change
FredoCorner > Assign to current scene
FredoGhost 3 Unmark objects
FredoScale % > Purge ALL data
FredoSpline > Auto-Switch by Distance
Choscomp 2 Compatibility with Layout
HoverSelect >
JointPushPull > About FredoGhost v1.0p.
MeshFromCloud > Video.. >
oundesey 2 Plugin Information [Sketchucation]..
ST 2 Check Fredob Plugins for Update:
SUClack > .
ToolsOnSurface > Donation.. 12
TopoShaper > Default Parameters...
Fredo6 Collection E > VisuHole > Language Translation.

| Contextual menu |

Whenever the selection includes a group or a component, the contextual menu shows
an entry for FredoGhost:

Ghost Studio
Create Ghost (current method)

Switch to Ghost
Switch to Real

Unmark objects
Auto-Switch by Distance

FredoGhost > Purge ALL data

| Quick Launcher |

This is a small floating window which displays all FredoGhost tools in a list. It can be
invoked from the menu or the toolbar icon:

S FredoGhost = [m} X

FredoGhost
@ Ghost Studio
‘¢ Create Ghost (current method)
& Switch to Ghost
& Switch to Real
‘= Refresh after change
@ Assign to current scene
# Unmark objects
@ Purge ALL data
(® Auto-Switch by Distance
® Compatibility with Layout

Optionally you can pin the Quick Launcher window on your viewport for subsequent
use. If unpinned, the window closes after you launch a command.

Warm thanks to JClements for designing the icons!
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| Configuration of contextual menu and toolbar |

All icons are shown right after installation, as well as all contextual menu entries.
However, you can configure which icons and menu entries are visible from the Default
Parameters dialog box. You can also change the name of the toolbar.

B Default Parameters: FredoGhost = m} X

Default Parameters: FredoGhost

T e e e TSP e TS SIS S ST =t o =
Switch ghost when scene transition ratio is at 0.0 g A
Plugin Configuration

Folder for Alternate Icons, cursors and other images : g
Toolbar name Fredo6_FredoGhost gee)

| Create Ghost (current method) o
Icons visible in the toolbar M switch to Ghost ged

M switch to Real v

V] Refresh after change
Top Menu |Fredo6 Collection (Sketchup - Tools) | v/ g

V| Ghost Studio "

&

Menus activated in the Selection contextual menu ¥ Crgate Lhosticunenémeitod) ;;’,ﬂ

V] Switch to Ghost .

V] Switch to Real v

Cancel Reset Factory Print Save changes

Note: Some changes may only be effective when you restart Sketchup

| Error HandlingJ

In some circumstances, FredoGhost may be unable to perform the operation, either
because the objects are too complex to handle or simply because there are still bugs in
the extension.

If this happens, you may get an error message shown as the dialog box below:

i Ruby Error == m} x

An error occurred in FredoGhost A
Error

undefined local variable or method "a’ for
#<F6_FredoGhost::FredoGhostTool:0x000001ff47483490>

Ruby File Line Method

FredoGhostTool.rb 3892 instruction_make_ghost A
FredoGhostTool.rb 3795  instruction_prepare
FredoGhostTool.rb 4105 step_prepare
FredoGhostRobot.rb 133 call

FredoGhostRobot.rb 133 start_machine_protected
FredoGhostRobot.rb 142 start_machine
FredoGhostRobot.rb 96 block in top_execute
Lib6Operation.rb 365 step_geometry
Lib60Operation.rb 413 start_execution
FredoGhostRobot.rb 96 top_execute

FredoGhostTool.rb 3685 robot_top_execute
FredoGhostTool.rb 3473  interactive_activation
FredoGhostTool.rb 2270 top_process

FredoGhostTool.rb 232 startup e

05-Mar-19 09:05:16

Print Export TXT Done [V

Although this is purely technical information related to the Ruby extension, it can be
useful for the author to trace the cause of errors. You can export this log as a txt file
(or simply copy / paste it) and post it on Sketchucation.
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4. Basic workflow

The typical FredoGhost workflow includes the following steps:

1) Object selection — Select groups or components in the model, using the native

SketchUp Selection tool (or the outliner).

2) Invoke the Ghost Studio dialog box

B FredoGhost Studio = m} x
[ ) Gﬁ\ O (& @
> < oK @ x A
Ghost Method Show Advanced feafures
Edge Mesh => Edge Color = black E |ZI
4 Make Ghost

Note 1: you can change the selection in the model while the Ghost Studio dialog box is
open.

A\ Note 2: You can shrink / expand the Ghost Studio dialog box, which can be useful to
select object in the model.

&1 FredoGhost Studio = O X

™

QB BB =v

- Pick a ghost method in the combo box.

Ghost Method Show Advanced features
Edge Mesh == Edge Color = black ﬂ E

Bounding Box == by sub-object
Clone the geomet

Edge Mesh == Edge Color = black

Grayscale

Masking => Face Color = white ; Desaturation = 0.30
Monochrome

NO Texture

Wireframe

X-Ray == Opacity = 0.50 ; Face Color = lightgreen
X-Ray == Opacity = 0.60

Note: A preview of the ghost transformation is shown at the bottom of the
Ghost Studio dialog box.
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You can optionally customize the ghost method by clicking on the Edit
button at the right of the combo. A dialog box will appear will all available
methods and their parameters.

'S Define a Ghost Method - [m] X
Bounding Box ;
= |
Wireframe Opacity 050
Ay Face Color ¥ [TightGreen <
Grayscale - J
Masking Edge Color O
Monochrome
Edge Mesh
Proxy
| Save in Sketchup X Cancel | ./ OK

Click the Make Ghost button to generate the ghosts for the selected
objects. By default, the selected objects are converted to their ghost
version.

Note 1: If there is no selection, FredoGhost will ask you to confirm whether you want to
apply the operation to all visible objects in the active context.

Note 2: You can re-apply a new ghost method to an object already ghosted. This can be
done whether the object is in its Real state or in its Ghost state.

This toolbar button can be invoked as a shortcut to perform the ghost
generation on the selection with the current ghost method (i.e. the last one
set in the Ghost studio).

3) Switch to Real or to Ghost

Use the buttons in the toolbar (or Ghost Studio) to switch the state of
objects, between their Ghost and Real versions.

The switch applies to the selection in the model, down to all nested levels.

If there is no selection, the switch applies to ALL visible objects in the
model, at any nested level.

4) Customizing ghosts with several methods

A ghost method applies to an object and ALL its embedded groups and
components at any nested level.

You can however assign another method to those embedded groups and
components.

= Just open the Ghost version of the top object at desired level

= Select one or several sub-objects

= Apply a ghost method to the selection

Step 1: Ghosting the table in XRay Step 2: Ghosting the tabletop in Monochrome yellow, one
lightgreen leg as original textured, one leg and 2 crossbars as edge-
mesh
Note: FredoGhost preserves the ghosting methods of the sub-objects if you later change
the method of the top object. If you wish to override this behavior, you must keep Ctrl
pressed when clicking on the ‘Make Ghost’ button.
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5) Refresh after Modifying objects

- You can freely modify the position of the objects, and apply them
regular transformations (scaling, rotation, flip), whether in their Real
state or in their Ghost state; the other state will get the same transformation.

ﬁ,‘ - If you modify a Real object, whether directly, or in another instance if it is
- a component, you will need to perform a Refresh. The corresponding icon
will automatically become enabled. Just click on it to refresh the ghosts for
the modified objects. Note that, until you perform this Refresh, the Ghost

and Real versions might be desynchronized.

&% 6) Unmarking objects

- To remove the ghosting of object(s) (i.e. Unmark), just select them and
click on the Unmark button. The object will be first converted to Real if
necessary and all information related to its ghosting will be removed.

) 7) Purging all FredoGhost data in the model

- You can remove all ghosting information in the model. Objects which
are in their ghost state will first be converted to their real version. This
action is radical, but it can be undone.

9 e 8) Undo / Redo
- FredoGhost fully relies on the native SketchUp Undo / Redo (Ctrl-
Z/Ctrl-Y, toolbar icons or menu).

9) Copying and Deleting objects
- If you copy an object which has been ghosted, then:
= For Groups, the new freshly copies groups will not inherit the
ghosting.
= For component instances, the new instances will optionally inherit
the ghosting based on the setting in the Default Parameters:

Inherit the ghost behavior when objects are copied
(Component instances only)

- You can delete an object, whether in its real version or ghost version.

Q 10) Copying, saving and transferring SketchUp model files

- All FredoGhost information is stored in the model. Therefore, the
information is kept across SaveAs or SaveCopyAs. You can freely copy
and transmit the skp files over the wires.

- If you transfer the model to a user not having FredoGhost installed,
then this user can freely work on the real objects. When transferring it back
to you, you may have to perform a Refresh in FredoGhost if some ghosted
objects have been modified.

IMPORTANT: be sure to convert all ghosted objects to their Real
versions before transferring the model.
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11) Modifying a Ghost

You can modify a Ghost by editing it, that is, by changing the content inside the
ghost group or component. This can be useful, in particular when you use Proxy
method where the replacing object may need to be adjusted for scale and
orientation.

Because this may be done intentionally or accidentally, you will see a confirmation
box the next time you switch the object to Real:

SketchUp X

o 1 Ghost(s) have been modified manually

Do you want to update them permanently?

Yes No Cancel

If you answer yes, then the modified ghost will become the registered ghost for the
object.

Note that if you create a ghost for the object with another method, the ghost
modifications will be lost.
12) Performance

The duration of each FredoGhost operations in indicated in the Measurement
window (label and value fields).

| Switch to Real 0.030s

As a general guideline:

- The construction of ghosts may take some time, as FredoGhost needs to
treat each face and edge of the original object, create and assign new
materials and textures to them. So, the response time for Make Ghost,
Refresh and Unmark depends on the complexity of the object.

- However, the switch between Real and Ghost state is uniformly fast,
almost independent of the complexity of the object. It is typically under
1/10™ second.
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5. Scene Capture and Layout compatibility

You can assign a ghosting state to a scene. A ghosting state is simply the list of objects
which are in their Ghost version. This functionality is available only if you have scenes
defined in the model.

i 1) Assigning a ghosting state to a scene

®

To assign the ghosting state to the current scene, just click on the Scene Capture
button, whether in the main toolbar or in the top button row of the Ghost Studio
dialog box.

If you wish to assign the ghosting state to several scenes or to another scene than the
current one, keep Ctrl pressed when clicking on the Capture button. You will get a
dialog box to select the target scenes.

S Selection of Scenes = O X

| ¥ 4 Scenes in model
[ o: Scene 1

[ 1: Scene2

2: Scene 33

[ 3: Scene4

Cancel Select

Then, when you select the Scene Tab, FredoGhost will automatically restore the
captured ghosting state.

IMPORTANT: you MUST use the Scene capture mechanism to tell FredoGhost
about which ghosting state to assign to the scene. An update of the Scene (native
update function) will not do it. Note that for scenes which have not been assigned a
ghosting state by an explicit capture, the change of ghosting state is not predictable
when you switch to the scenes.

Layout Compatibility
[if you don’t know what Layout is or do not use it, you can skip this section]

Layout is based on scene settings to display views of the model(s) in the layout
document. The issue pertaining to FredoGhost is that scenes only keep track of the
camera, layers visibility, style, sections, .... but NOT the state of objects. To work
around these issues, FredoGhost implements two modes for switching objects
between their Ghost and Real versions:

= Definition Substitution: the definition of the objects is changed. Therefore,
the ghosted object is the same group or component instance as the original
object. This is the default mode. This mode is NOT compatible with Layout.

= Layer Visibility: FredoGhost creates the ghost as a separate object, coexisting
with the original one, and assign distinct layers to the Real and Ghost objects,
making sure that only one is visible at any given time. This mode is
compatible with Layout, as it is based on layer visibility only.
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You can freely switch the model between the Definition Substitution and Layer
Visibility modes, back and forth. The information on ghosting is kept intact in both
modes. This is achieved by toggling the button:

A f
Definition Substitution mode : NOT compatible with Layout Layer Visibility mode : compatible with Layout

With the Layout compatible mode, you can mix up viewports with different states of
ghosting (and therefore styling).

For instance, in each of the 4 SketchUp scenes below, one chair is ghosted with a
different method.

Scene 2

Scene 3 Scene 4

The corresponding layout file can display the 4 scenes with the 4 ghosting states:

Scene 1 Scene 2

Scene 3 Scene 4

Fredo6 — FredoGhost Page 12/ 24 v1.2 - 03 Jun 2019



There are however a few inconveniences with the Layout mode:

- FredoGhost creates technical layers, which, unfortunately, cannot be hidden
in the layer manager. They are all prefixed with ZzZ_FGh__. You should ignore
them and never change their visibility state manually.

Name Dashes

@& Layer) . Default
@ cache B oefoutt
@ 1ot [ cefourt
< ZZFGh_1R Default
@ ZZ FGh_43 R Default
<O ZZ_FGh_81 R Default
@& 77 FGh__200_H Default
< ZZ_FGh__203 H Default
@ ZZ_FGh__207_H Default

- An original object is assigned a technical layer (zz FGh__ ), which replaces its
original layer (i.e. natural layer). However, FredoGhost keeps track of the
natural layer of the real object. Say that the original object was on layer
‘Cache’. If you hide or show this natural layer ‘Cache’ in the model, then both
the real and ghost versions of the object will be hidden or shown accordingly.

Likewise, you can change the natural layer of the original object in SketchUp
(via the Entity info box). Right after you do it, FredoGhost will substitute the
new natural layer by a technical layer but will remember this new natural layer
assignment.

- Since there are two objects in the model for each original object, one hidden,
one visible, this may create problems with extensions that do not consider
object visibility when scanning the model.
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6. Ghost Methods

Ghost methods are based on a core algorithm, complemented by optional parameters (for
instance, X-Ray has the choice of opacity and masking color). The combination of the
algorithm and the parameters instantiates an active ghost method.

In a model, the list of active ghost methods is shown in the Ghost Studio dialog box, in the
combo box, coming from 3 sources:
- Predefined methods (in blue)

- Methods used in the model and already assigned to some objects (in green) or
defined in the current session.

- Methods saved at SketchUp level (in red).

Bounding Box ==> by sub-object
Clone the geometry

Edge Mesh => Edge Color = Red
Edge Mesh => Edge Color = black
Grayscale

== Face Color = white ; Desaturation = (.30
Monochrome
Monochrome == Face Color = SpringGreen
NO Texture
Wireframe
X-Ray == Opacity = 0.50 ; Face Color = lightgreen
X-Ray == Opacity = 0.60

Some methods do not have parameters, like Clone Geometry and NO texture. Others can
be customized with parameters via the Ghost Method Editor.

B Define a Ghost Method - O X
Bounding Box
; i 5
Wireframe Opacty 1 i
X-Ray f ap |
————————— | Mask Color IWh\te v . L
Grayscale . . o
iMacking | e 5 . ,
Monochrome R i
Edge Mesh Edge Color | 1\ i 4
Proxy “ _ 3
Color by layer
I Save in Sketchup X Cancel |/ OK

FredoGhost illustrates the rendering for each method and parameters based on a template
shape? shown in real version and in ghosted version. FredoGhost tries to simulate the
rendering as accurately as possible, at least for SU2018+.

2 Note that this template shape may change with future version of FredoGhost.
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Specifyving Edge Colors

Styling methods usually have a property Edge Color. The 3 buttons on the right are
shortcuts to set the edge color to Black, Gray and Blend. There are 3 options:

Edge Color 0 Edges are not painted
Edge Color W [Orange N | Edges are painted in the specified color
Edge Color i [blend T~V . Edges are painted with a blending of the colors of

their bounding faces (for methods painting faces)

Saving a ghost method at SketchUp Level

= You can define as many methods as you like in the Ghost Method editor.
However, they will be available in the SketchUp session only, unless they are used
on objects in the model.

* You can however save a method and parameters for all SketchUp sessions?,
regardless of the model. Just press the Save button:

ke Save in Sketchup
You will be prompted for a method nickname. By default, the name is the
expanded list of properties of the method.

Save a method across Sketchup sessions X

Method Name ing => Desaturation = 0.75 ; Mask Color = black|

If you give it a nickname, say “My Method”....

Save a method across Sketchup sessions X
Method Name |My Mthod |

...it will then appear in the main dropdown list of methods in ‘red’, with the
method code and the nick name. The tooltip indicates the details of properties.

Masking == Desaturation = 0.30

Masking => Desaturation = 0.30 ; Edge Color = blend
Masking == Desaturation = 0.30 ; Mask Color = black
Masking == Desaturation = 0.75 ; Mask Color = black

T RS TG hite ; Desaturation = 0.30
Wasking [My Method]

oo

Meonochrome => Opacity = 0.25 ; Edge Color = blend ; Face Color = SandyBrown
Monochrome => Opacity = 0.50

» If ever you want to remove this method, select it in the main combo box of the
Ghost Studio and then open the Ghost Method editor; you will see that the Save
button is now changed to a Forget button:

€) Forget

3 As well as all SketchUp versions, past and future
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The following sections describe the methods available in the current version of
FredoGhost — See separate document for more details.

Ghost method Simplifying | Styling

Proxy Object: substitution by an arbitrary object

Clone Geometry: make a strict copy of the real object

No Texture: replace all textures by flat average colors

X-Ray: change the opacity of faces, with optionally assigning a
color to faces and edges

Masking: apply a color mask to the faces, to make them
desaturated, i.e. lighter or darker or water-colored.

Grayscale: paint the faces in their grayscale color. Optionally,
you can apply a mask to lighten or darken the grayscale.

Color by Layer: paint the objects with their layer color

Monochrome: paint the objects with a single color

Bounding Box: replace objects by their bounding box

Edge Mesh: replace objects by their edge skeleton

Wireframe: replace objects by their simple wireframe as in SU
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7. Advanced Features

To reveal the advanced features of FredoGhost, you need to expand the Ghost Studio

dialog box:
&1 FredoGhost Studio = [ X
o @ G,\ D @ @\9 @
> <= e K '@ KA
/" Configurati =
guration |toto v =
& FredoGhost Studio = Ia] X J +X8S
o — = > Ghost Method Hide Advanced features
[ 2eh | (})] u e N
. <= = % o G?Q @ R A Edge Mesh => Edge Color = Red ﬂl—,i“
Ghost Method Show Advanced features < Make ghost for l Salection I“ Al |_“ Others
Euge Mosh = Eogo Color—Red - RS
Auto-switch by distance on Off
4 Make Ghost Freeze ghost Oon  Oof
Make Unique O
-
-
A
/ \ \?\ |
o
-
"-\".“.'\‘qk"l":ﬁﬁ
‘.‘\\.I:'\:'\ i 1\l
L
L LT
e
i ‘.\““_: |
Wik

Basic Features

Advanced Features

There are 5 advanced features:

= Auto-Switch by distance

* Freezing of ghosts

= Unique ghosts
Advanced selection for component instances
» Configurations

1) Auto-switch by Distance

FredoGhost provides a mechanism to automatically switch between ghost and real
versions based on the visible size of the object in the current view. Basically, if an

object is far away and appear small enough in the SketchUp viewport, then it would be
switched to its ghost version.

Although this applies to any ghost methods, it would probably be the most useful for
simplification methods (for instance replacement by a bounding box), since the
intention would be to make the active model lighter for a smoother navigation.

To make object sensitive to distance

Objects are not sensitive to distance by default. You need to explicitly assign them
this characteristic, using the check boxes:

Auto-switch by distance Oon Oof

Fredo6 — FredoGhost Page 17/ 24 v1.2 - 03 Jun 2019



The usage of the two check boxes allows to be explicit, since you can operate on
objects which are already ghosted and sensitive or not to distance.

= ON will force the distance sensitivity

= OFF will remove the distance sensitivity

= ON and OFF unchecked will leave the property as-is for each object.

The setting of distance sensitivity can be done:

a) At creation of the Ghost.

b) Later on, by selecting the target objects. In such a case, if you check the ON
or the OFF box, an ‘Apply’ button will appear. This allows to set or unset
the property without regenerating the ghosts.

Auto-switch by distance Mon [of Apply

Auto-switch by distance [Jon Off Apply

To enable Auto-Switch by distance in the SketchUp session

You must explicitly set the auto-switch capability for the model by toggling the

button:
(o (®

When the Auto-Switch is ON, a change of view may trigger a switch between real
and ghost versions for some objects. For convenience,
» No switch takes place while you are using a Tool (native or extension)

» The potential switch takes place half a second after you changed the view,
so that you can smoothly zoom, orbit or pan with the mouse.

The algorithm to determine when to switch is based on the arc angle of the object
viewed from the camera. Default is 8 degrees. You can change this parameter in
the Default Parameters of FredoGhost.

Arc angle for auto-switch of distance (degrees) |8,0 el
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2) Freezing of Ghost

FredoGhost keeps the ghost version in sync with the real version. However, you may
want to freeze the shape of the real object to preserve a fixed reference for its
ghost version.

This would be useful if you plan to make a real object more complex (e.g. adding
details or chamfering for instance). The ghost would remain simple, but realistic,
while you add geometric complexity of the real object.

Original object Frozen ghost Adding details to the The ghost keeps
real object reference to the
original object

To freeze ghosts

Ghost are not frozen by default. You need to explicitly specify this characteristic,
using the check boxes:

Freeze ghost Oon QOoOF

The usage of the two check boxes allows to be explicit, since you can operate on
objects which have already frozen ghosts.

= ON will force a ghost freeze

= OFF will remove the ghost freezing and resume synchronization

= ON and OFF unchecked will leave the property as-is for each object.

The setting of frozen ghost can be done:

a) At creation of the Ghost.

b) Later on, by selecting the target objects. In such a case, if you check the ON
or the OFF box, an ‘Apply’ button will appear. This allows to set or unset
the property without regenerating the ghosts.

Freeze ghost Mon [OoOff Apply

Freeze ghost Oon [MoOff Apply
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3) Unique Ghost

This function concerns the case where you assign ghosts to SEVERAL instances of the
SAME component definition in one operation.

In this case, FredoGhost construct only a single ghost reference shared by all these
instances. This means that any customization of this ghost (i.e. changing the method of
sub-objects) will affect the ghost versions of all these instances.

The Unique function allows to force individual construction of a ghost, one by
instance. You can set it:

a) At creation of the Ghosts.

Make Unique ]

b) Later on, by selecting the target instances. In such a case, if you check the
box, an ‘Apply’ button will appear. This allows to set the property without
regenerating the ghosts.

Make Unique ] Apply

4) Advanced selection of component instances

This function concerns the cases where you want to assign ghosts to several instances
of the same component definition in a single operation.

Based on what is selected in SketchUp, FredoGhost offers 3 options:
Make ghost for | | Selection | |l A0 [l Others

= Selection applies ghost creation to what is selected,
= All applies to all instances in active context, whether they are selected or not,
= Others applies to all other instances in the model at the same level, EXCEPT

those which are selected.

The purpose of this function is to ease the selection when you have numerous
instances of the same component definition spread out in the model.

IMPORTANT: the ghost is shared between the instances. This means that if you
customize a sub-object of the ghost, it will apply to all these instances.

Fredo6 — FredoGhost Page 20/ 24 v1.2 - 03 Jun 2019



5) Ghosting Configurations

Configurations are independent ghosting contexts within the same model.

This may be useful if you wish to create ghosts with DIFFERENT methods for the SAME
object, for instance to get distinct viewports in Layout where the same object would be
in XRay or in Wireframe.

Configurations are managed by a combo box and 4 buttons to Create, Delete,
Duplicate and Rename a configuration.

Configuration  Config 0 vMEXBED

The current configuration is indicated in the combo box. By default, you work with
Config 0. Here are the operations that can be performed on configurations:

Change of configuration: select the configuration in the drop box. All objects
will be first converted to their real version.

Add a new configuration: click on the + button. You will be prompted for a
name. All objects will be first converted to their real version. From there on,
any ghost creation will be assigned in the context of this configuration.

Duplicate a configuration: click on the & button. You will be prompted for a
name. The new configuration is created as a copy of the current one. The
ghosting state remains unchanged.

Delete a configuration: click on the X button. All objects will be first
converted to their real version. The current configuration is changed to another
one. If you have no other configuration, the current configuration will be
Config 0, with an empty ghosting context.

Rename a configuration: click on the % button. You will be prompted for a
name.
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8. Default Parameters

There are a few configuration settings which can be changed in the Default Parameters
dialog box, reachable by:

1)

2)

3)

4)

5)

6)

The menu Tools > Fredo6 Collection > FredoGhost > Default Parameters...
The small wrench icon # on the top-right of the Ghost Studio dialog box

Active Options at start up

Convert objects to ghost when making ghost
Inherit the ghost behavior when objects are copied
(Component instances only)

Layout compatibility by Default Il

Indicate the ghosting status in the object name ([Ghost]

Auto-switch to Ghost when the ratio [object size / viewport

size] is smaller than (in %) |5'0

Retention time of Unit Ghosts (minutes) |1 50

Convert objects to ghost when making ghost: when you make a ghost out of a
real object, it is converted to its ghost version. You can change this behavior and
not perform any conversion.

Inherit ghost behavior when objects are copied, when you copy a component
instance, via the Move-Copy, or via the Copy-Paste.

Note that if the object is a Group, it will not inherit the ghosted behavior.

Note also that if you insert a component instance from the Component Browser, it
will not inherit any ghosting too.

Layout compatibility by default: this is the compatibility mode for the model
when you create the first ghost. Note that you can dynamically change it.

Indicate the Ghosting status in the object name: by default, FredoGhost
prepends a [Ghost] prefix to the object name to show visually that the object is in
a ghost state.

Component (2 in model)

Layer: | Cache ~
Instance: | [Ghost]my comp
Definition: | Group53#2

Toggles: @ ' ® O

As this may interfere with other SketchUp operations and extensions using object
names, this option is left open.

Retention time of unit ghosts: this is a technical option related to the ghost
generation (see next section ‘under the hood’).

Arc Angle for auto-switch by distance: this is the visible angle of the object that
triggers an automatic switch between the ghost and real version of objects. I may
come with a smarter algorithm in a next version.
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9. Under the hood

As FredoGhost is an extension, not a native functionality, it is good to understand how it
works under the hood, especially because, in the current version of the API, the nitty-
gritty of internal processing cannot be hidden completely.

When FredoGhost creates a ghost:

= It makes a copy of the original object and its sub-objects (an instance of their
definition actually)

= It generates a ghosted version for all individual sub-objects, so that this can be
reused for partial ghosting or when sub-objects are shared with other objects in the
model.

= It assembles these ghosted sub-objects into a composite definition, to be used
as the ghost version of the original object.

All these elements are enclosed in a dedicated group, called Capsule, which is assigned a
technical Layer ZZ_ FGh_Capsule set to invisible®.

Model in Real version Model in Ghost version
The capsule is shown on the left.

This means that the model gets additional geometry. As it is invisible, this should not alter
the performance of navigation in the SketchUp viewport. However, even if it is invisible,
the size of the skp file will increase. Because FredoGhost uses instances of definitions for
copies of real objects, the increase of size is really related to the ghosted versions.

Note: By default, FredoGhost minimizes the persistent technical objects and keeps only the spare
copies and top ghosts in the Capsule. This may impact performance when you generate ghosts
from objects which have elements already ghosted, as these ghosted elements need to be
regenerated. FredoGhost provides an option to cache these unit ghosts for a limited period of time
(15 minutes by default):

Retention time of Unit Ghosts (minutes) |1 5

FredoGhost also maintains information related to the ghosting state as attributes of
objects, scenes, layers and model. These attributes are all encoded in dictionaries with
names prefixed by FredoGhost. It is of course strongly advised NOT to alter these
attributes in any way.

4 I left the capability to manually unhide the capsule layer if you wish to see what it contains.
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FredoGhost keeps track of the ghosting state and cleans up the Capsule according to the
operation of ghost creation and unmarking.

The PURGE ALL command erases every trace of FredoGhost in the model, the capsule and
all attributes. It is therefore a radical cleanup.

A few notes on what happens to the real objects:

= In Definition Substitution mode: the Real object is not altered, except its
definition which is changed when converted to ghost. So, it keeps all its original
attributes whatever is the version, since it is the same object.

= In Layout Compatible mode: the Real object is untouched, except for its layer
which is replaced by a technical layer. The Ghost version is however another
object and does not carry the original attributes of the real object. Furthermore,
FredoGhost must synchronize the position and transformation of the Real and
Ghost versions.
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